MS Outlook 2007 training

Facilitator: Joanne Garcenila Calinao

Email address: garcenjv@umdnj.edu
We will be looking at

- What’s new in Outlook 2007
- Getting Started with Outlook 2007
- Messages and Text
  - sending a message and formatting text
  - Manipulating messages
- Organizing Mail
- Contacts
- Calendar
- Tasks and Notes
What’s new in Outlook 2007?
The Ribbon

The Ribbon is at the top of the window.

The Ribbon is to help you get things done more easily and with fewer steps.
Instant Search

Provides a new fast way to find your information, no matter which folder it is in.
Getting Started with Outlook 2007
Opening Outlook 2007

Go to **Start**, **All Programs**, **Microsoft Office** then **Click on Microsoft Office Outlook 2007**
Outlook 2007 Window

- **Menu Bar**
- **Standard Toolbar**
- **Navigation Pane**
- **View Pane**
- **Reading Pane**
- **To Do Bar**
• **Mail** – the main area where you can read, compose, receive and send email.
• **Calendar** – the scheduler, or planner, where you can set and manage appointments and tasks.
• **Contacts** – contains your contact list where you can store names, e-mail addresses, and other information.
• **Tasks** – the task list where you can create and manage tasks
• **Notes** – the notes page where you can create and manage notes
• **Folder List** – displays all folders in a hierarchical format.
• **Shortcuts** – displays shortcuts.
To-Do Bar

Located at the far right of the window, the To-Do Bar is visible wherever you happen to be working in Outlook.

The To-Do Bar is there to help you keep track of upcoming tasks and appointments.

The picture calls out a few of its key elements:

1. Date Navigator
2. Upcoming calendar appointments
3. A place to enter new tasks by typing
4. Your task list
Outlook Help

Click here

Type a keyword of your topic here
Out of office message

Click Tools

This feature sends an automatic response message while you’re out of the office.
Out of office message – Out of office assistant window

1. Select Send Out of Office auto-replies and put a check mark on the box “Only send during this time range:” Select the Start time and End time.

2. Next, you can type a customized message that will be used to auto reply to messages sent by others. You can set up messages for both inside and outside of your organization.

Type your message on this space.

Click Ok
The Ribbon

The Ribbon is at the top of the window.

The Ribbon is visible each time you create or edit something in Outlook.

Outlook commands are now more prominent, and common commands are displayed and grouped in ways that make them easy to find and use.

The Ribbon is to help you get things done more easily and with fewer steps.
A closer look at the Ribbon

To better help you learn how to use the Ribbon, here’s a guide to its basic arrangement.

1. **Tabs**: The Ribbon is made up of different tabs, each related to specific kinds of work you do in Outlook.

2. **Groups**: Each tab has several groups that show related items together.

3. **Commands**: A command is a button, a box to enter information, or a menu.
The Ribbon shows what you need

Once again, you’ll encounter the Ribbon when you take certain actions such as creating messages, calendar entries, or contacts.

The Ribbon shows tabs and commands appropriate for what you’re doing.

The tabs on the Ribbon will differ depending on the area of Outlook you’re working in.

For example:

1. A new message shows the Message and Options tabs.
2. A new appointment shows the Appointment tab.
3. A new contact shows the Contact tab.
The Quick Access Toolbar is a small toolbar above the Ribbon. It’s there to make the commands you need and use most often readily available.

What’s best about the Quick Access Toolbar? What’s on it is up to you. That is, you can add your favorite commands to it with simply

This row of buttons above the Ribbon, already contains several buttons by default, but you can add new commands.
Lesson I: Messages and Text

Sending a message & formatting text

a. Compose a New message
b. Sending an email > To, CC, BCC (Blind Carbon Copy)
c. Search for email address
d. Attach File, Attach Item, Set message with High importance
e. Create Signature, Insert Signature and Choosing default signature
f. **Options tab** Show BCC, Request a Delivery Receipt, Request a Read Receipt
Sending a message & formatting text

a. Compose a New message, From menu bar click on **File > New > Mail Message**
Or Select Mail on Navigation Pane > Click New

Select Mail on Navigation Pane
b. Sending an email > To, CC, BCC (Blind Carbon Copy)

Click To button – select recipient’s email address
Click Cc – copy a person to this email
Click BCC - Blind copy a person to this email

In addition to selecting a recipients email To, you can start typing the last name of the person then Press Ctrl-K. This will also open the Address book window.
c. Search for email address on Message tab select Address book
d. **Attach File**, Attach Item, Set message with High importance

**Attach File**

Click here to Attach File

Click Insert

**Attach File**

Click here to Attach File

Click Insert
Sending a message & formatting text

d. Attach File, **Attach Item**, Set message with High importance

**Attach Item**
Sending a message & formatting text

d. Attach File, Attach Item, **Set message with High importance**

**Set message with High importance**

Click here to set message with high importance
Sending a message & formatting text

e. **Create Signature**, Insert signature, Choosing Default Signature

1. Click here to open Signature box
2. Click New to create new signature
3. Enter the name of your signature and click OK
4. Type signature here.
5. Click OK
Create Signature, **How to Insert Signature**, Choosing Default Signature

You can setup a default signature so it will appear each time you create a new message.
Create Signature, Insert Signature, **Choosing Default Signature**

New Message

**Replies/forward message**

Click Signature button

Click here to open the Signature window

Click Ok when done with selection.
Lesson 1: Messages and Text

f. **Options tab** you can **Show BCC**, Request a Delivery Receipt, Request a Read Receipt

If you add a recipient's name to this box in a message, a copy of the message is sent to that recipient, and the recipient's name is not visible to other recipients of the message.
Lesson 1: Messages and Text

f. **Options tab** you can Show BCC, **Request a Delivery Receipt** and **Request a Read Receipt**

A delivery receipt informs you that your e-mail message was delivered to the recipient's mailbox, but not that the recipient has seen it or read it.

A read receipt informs you that your message has been opened.
Lesson I: Messages and Text

Manipulating messages

- Select a message, Delete, Move to Folder
- Preview a message
- Opening a message and viewing it on a new window
- Reply, Reply to all and Forward message, double click on message see commands on Respond group
- Opening and saving an attached file
- Printing a message
- Adobe PDF tab – Convert to Adobe PDF
Lesson I: Messages and Text

Manipulating messages

g. **Select a message**, Delete, Move to Folder
Lesson 1: Messages and Text

Manipulating messages

h. Select a message, **Delete a message**, Move to Folder

- Right click on a message
- Click Delete
Lesson I: Messages and Text

Manipulating messages

g. Select a message, Delete a message, **Move to Folder**

To move a folder, Drag and Drop the selected message to a folder on the left.

---

Select a message, Delete a message, **Move to Folder**

To move a folder, Drag and Drop the selected message to a folder on the left.
Lesson I: Messages and Text

Manipulating messages

h. Preview a message
Lesson 1: Messages and Text - Preview Message

How to change the Reading pane view to **Right View** and **Bottom View**

1. Click **View** on the menu bar.
2. Select **Reading Pane** from the dropdown menu.
3. Choose your preference for the reading pane view.
Lesson I: Messages and Text

Manipulating messages

i. Opening a message and viewing it on another window.

This is the message on a separate window.
Lesson I: Messages and Text

Manipulating messages

Click Send

Type your reply message here

This is my reply message

From: Hu, Po
Sent: Wednesday, July 28, 2010 3:17 PM
To: Boyce, James; McNeil, Audrey; Terry, Courtney; Garcenia, Joanne
Subject: RE: Oracle Production Migration-Upgrade test

Hi,

The demo test data source has been set up. Now eduman and njmsvideo on demo are connecting to the new data source. Please test all functions of eduman and njmsvideo. Since this is demo database, you can test whatever you want. After we finish testing this, I will create data source for production, then you can test that one. Please remember we have a cut-over date so please test it as early as possible, in case we find any problem, they still have time to fix it.

You can access eduman from: [https://19.32.4.103/mbm/myprofile](https://19.32.4.103/mbm/myprofile)
NJmsvideo on demo from: [http://10.32.4.103:8080/videodemo/login.cfm](http://10.32.4.103:8080/videodemo/login.cfm)

Best Regards,
Po Hu
Lesson 1: Messages and Text

Manipulating messages

Type your message here

Click Send

Type Reply to All message here

From: Hu, Po
Sent: Wednesday, July 28, 2010 3:17 PM
To: Boyce, James; McNiel, Audrey; Terry, Courtney; Garconila, Joanne
Subject: Oracle Production Migration-Upgrade test

Hi,

The demo test data source has been set up. Now eduman and njmsvideo on demo are connecting to the new data source. Please test all functions of eduman and njmsvideo. Since this is demo database, you can test whatever you want. After we finish testing this, I will create data source for production, then you can test that one. Please remember we have a cut-over date so please test it as early as possible, in case we find any problem, they still have time to fix it.

You can access eduman from: https://10.32.4.103/mbm/myprofile
Njmsvideo on demo from: http://10.32.4.105:8089/videoarchive/fugen.cfm

Best Regards,
Po Hu
Lesson 1: Messages and Text

Manipulating messages

Type your message here:

From: Hu, Po
Sent: Wednesday, July 28, 2010 3:17 PM
To: Royce, James; McNeil, Audrey; Terry, Courtney; Garcenila, Joanne
Subject: Oracle Production Migration-Upgrade test

Hi,

The demo test data source has been set up. Now eduman and njmvideo on demo are connecting to the new data source. Please test all functions of eduman and njmvideo. Since this is demo database, you can test whatever you want. After we finish testing this, I will create data source for production, then you can test that one. Please remember we have a cut-over date so please test it as early as possible, in case we find any problem, they still have time to fix it.

You can access eduman from: https://10.32.4.103/mbm/mypost
Njmvideo on demo from: http://10.32.4.103/8889/videodemo/login.cfm

Best Regards,

Po Hu
Lesson 1: Messages and Text

Opening and saving an attached file

Double click on this message with attachment.
Lesson 1: Messages and Text

Click the button or File > Print to print the attached file.

Double-click on this message to open and print the attached file.

Double-click on this attached PDF file.

Click Ok to Print.
Lesson 1: Messages and Text

Manipulating messages

I. Printing an email message

There are different ways to print a message and this is one of them. You can also print by clicking the Office button > Print. I’ll show you two ways to do it on the next slide.

Click the print button
Shortcut buttons when you right click on a message
Lesson I: Messages and Text

Click Convert to Adobe PDF button

Enter file name

Save
Lesson I: Messages and Text

Organizing Mail

n. Searching for a message - Type a keyword in *Search Inbox* box
o. Creating a new mail folder - Right click on Mail navigation Pane, Select *New Folder*
p. Moving *item* from Outlook to a different folder or other location
q. Delete mail folder - Right click on a folder (ex. Test New Folder), Select *Delete “Test New Folder”*
r. Delete a message - Right click on the message, Select *Delete*
s. Recover a deleted message – In the folder from where you deleted the item, or select Deleted Items folder, click *Recover Deleted Items* on the *Tools* menu.
t. Marking a message as unread – Right click on message, select *Mark as Unread*
Lesson I: Messages and Text

Organizing Mail

n. Searching for a message

Type a keyword in Search Inbox box

Keyword can be subject, name of sender and Date received.

When do you use this feature? This is used when you are looking for a specific message in a folder sent weeks or days ago.
Lesson 1: Messages and Text

Creating a new mail folder

Organizing Mail

Enter the name of your new folder here ex. Test

Click Ok

Right click on a folder where you like the new folder to be located, Select New Folder
p. Moving *item* from Outlook to a different folder or other location

*Item* refers to email message or attachment.

Use **Drag and Drop** feature

• Select the *item* you want to move.
• Drag to the destination folder, and then release the mouse button.

Also, you can drag and drop a file from your desktop or other location (ex. K drive) as attachment to a New Message.
Lesson 1: Messages and Text

Organizing Mail

q. Delete mail folder - Right click on a folder (ex. Test New Folder), Select Delete “Test New Folder”
Lesson 1: Messages and Text

Organizing Mail

- Delete a message

Right click on the message

Select Delete
Lesson I: Messages and Text

Organizing Mail

s. Recover a deleted message

Microsoft Office Outlook 2007 provides a way to recover items after you delete them permanently, even after you empty the Deleted Items folder.

Select Tools menu
In the folder from where you deleted the item, or in the Deleted Items folder, click Recover Deleted Items on the Tools menu.

Take note: You have two weeks to recover your deleted message.
Organizing Mail

t. Marking a message as unread

Right click on message

select Mark as Unread
Lesson II: Contacts

a. Adding a new contact
b. Adding the sender of a message to contacts
c. Deleting a contact
d. Sort Contacts – Click small icons: Sort by From, Subject, Date Received, Importance, and Size
e. Find Contacts using Address book
f. Select **Contacts** on Nav Pane, Click ▼ dropdown arrow next to New, select Distribution list
g. Add new email address to distribution list
h. Remove an email address from a distribution list
i. Sending an email to distribution list
Lesson II: Contacts

a. Adding a new contact

You can also add a new contact from the Mail navigation and by pressing shortcut keys. I’ll show you on the next slide.

Select Contacts on Navigation Pane

Click New

Click Save

Fill in the information
Or from Mail navigation to add a new contact

Or use shortcut by Pressing Ctrl-Shift-C anywhere you’re in outlook.
Lesson II: Contacts

b. Adding the sender of a message to contacts

Let’s say a message is now selected and it’s open.

Right click on sender’s name

Select Add to Outlook Contacts
Lesson II: Contacts

c. Deleting a contact

- Right click on the name of a contact
- Select Delete
- Select Contacts from the navigation pane

Or click this Delete button
Lesson II: Contacts

d. Sort Contacts

Simply click on how you would like it sorted, for example Full name.

Sort contacts by Full name, Company, File As, Business phone, Business Fax, Home Phone, Mobile Phone and more...
Lesson II: Contacts

e. Find Contacts using Address Book

Type the person’s name on this box

Or Press **Ctrl-Shift-B** to open the address book anywhere in Outlook.
Lesson II: Contacts

f. Creating a new distribution list

A distribution list is a collection of contacts (contact: Person, inside or outside of your organization.) It provides an easy way to send e-mail messages to a group of people. For example, if you frequently send messages to the marketing team, you can create a distribution list — called "Marketing Team".

1. Click dropdown arrow next to New
2. Select Distribution List
3. Click Save
4. Enter the name of the distribution list
5. Add New Member to Distribution list are people from your contact list.
6. Select Members will open the address book window.
g. Add new email address to an existing distribution list

1. Double click on your existing distribution list.
2. Click Add New to add a member on your existing distribution list.
Lesson II: Contacts

h. Remove an email address from a distribution list

Double click on your existing distribution list.

Click Remove

Select a member on your list
Lesson II: Contacts

i. Sending an email to distribution list

- Double click on your existing distribution list.
- Select Email.
Lesson III: Calendar

a. Explore Outlook Calendar
b. Change view of calendar – View menu select Current view
c. Schedule or add an appointment - Click Calendar Navigation Pane click New
d. Edit appointment – Double click on the appointment
e. Delete appointment – Right click on appointment, select Delete
f. Sharing a calendar – Calendar Navigation Pane on the left click Share my calendar
1. Using Calendar

a. Explore Outlook Calendar

The new design of the calendar in Outlook 2007 will notice that it's easier to see what's what.

The picture shows some examples:

1. Bigger buttons make it easier to quickly switch between **daily**, **weekly**, and **monthly** calendar views.
2. **Back** and **Forward** buttons let you quickly go to the next day, week, or month in the calendar.
3. **Tasks** - You can use this area to track your accomplishments: Completed items on this list appear crossed out and "stick" to the day; tasks not marked as complete will automatically be carried over to the next day, until you complete them.
Lesson III: Calendar

b. Change view of calendar – View menu select Current view
Click on the Calendar button in the Navigation page to view your default calendar.
Two calendar views
Lesson III: Calendar

c. Schedule or add an appointment

Click Save

Subject: 
Location: 
Start time: Fri 8/27/2010 9:30 AM All day event
End time: Fri 8/27/2010 10:00 AM
Lesson III: Calendar

d. Edit an appointment

Click Save

Double click the appointment
Lesson III: Calendar

e. Delete appointment

Right click on the appointment
Select Delete
Lesson III: Calendar

f. Sharing a calendar

- Enter recipients' address here
- Select your preference
- Click Send
- Type your message here
Lesson IV: Managing Tasks and Notes

a. Create a task

b. Edit and Update a Task – Double click on task and make your edit, Save & Close

c. Create a note – Select Notes on Navigation Pane, Click New

d. Edit note- Select Notes on Navigation Pane, Double click on the note you like to edit.

e. Display a note on the Desktop-Drag and drop to desktop

f. Print a note- Right click on a note, Print
Lesson IV: Managing Tasks and Notes

Click Save

Create a task

You can create a task anywhere in Outlook by pressing Ctrl-Shift-K or Click New. Fill in the ff fields

Select Task Type

Type your task detail here
Lesson IV: Managing Tasks and Notes

- Click Save

Subject: Demo link
Start date: Thu 3/11/2010
Due date: Thu 3/11/2010
Status: Not Started
Priority: Normal
Owner: Joanne Garcenila

https://10.32.4.103/mbm/myprofile/index.cfm
Lesson IV: Managing Tasks and Notes

c. Create a Note

You can create a Note anywhere in Outlook by pressing Ctrl-Shift-N or click dropdown next to New. Click New, Select Note Type, your message here. Click X after typing your note. It automatically saves it. You select Notes on Navigation pane and you’ll see the note you created.
Lesson IV: Managing Tasks and Notes

d. Edit note- Select Notes on Navigation Pane, Double click on the note you like to edit.

Click Notes on Navigation Pane

Double click on the note when it’s open
just type your changes and Click X to save it.
Lesson IV: Managing Tasks and Notes

e. Display a note on the Desktop

Drag and drop a note to desktop
Lesson IV: Managing Tasks and Notes

f. Print a note - Right click on a note > Print
Additional Information - Advanced
Rules and Alerts

Rules Wizard

Start from a template or from a blank rule
Step 1: Select a template

Stay Organized
- Move messages from someone to a folder
- Move messages with specific words in the subject to a folder
- Move messages sent to a distribution list to a folder
- Delete a conversation
- Flag messages from someone for follow-up
- Move Microsoft Office InfoPath forms of a specific type to a folder
- Move RSS items from a specific RSS Feed to a folder

Stay Up to Date
- Display mail from someone in the New Item Alert Window
- Play a sound when I get messages from someone
- Send an alert to my mobile device when I get messages from someone

Start from a blank rule
- Check messages when they arrive
- Check messages after sending

Step 2: Edit the rule description (click an underlined value)

Apply this rule after the message arrives
from people or distribution list
move it to the specified folder

Example: Move mail from my manager to my High Importance folder

Cancel  < Back  Next >  Finish
Add or Remove Sharing Permissions
Create, View or Delete a group schedule

• In **Calendar**, on the **Actions** menu, click **View Group Schedules**.

• Do one of the following:
  – **Create a group schedule**
    • In the **Group Schedules** dialog box, click **New**.
    • Type a name for the new group schedule, and then click **OK**.
    • Click **Add Others**, and then click either **Add from Address Book** or **Add Public Folder**.
    • Select the names or the public folders that you want to add, and then click **OK**.
    • Click **Save and close**.
  – **View a group schedule**
  • Select the group schedule that you want to view, and then click **Open**.
  – **Delete a group schedule**
  • Select the group schedule that you want to delete, and then click **Delete**.
Thank you!